




I.  Overview  

 A. Brief Summary and Project Period  

Sample the northern Gulf of Mexico (GOM) with 90 ft high-opening fish trawl to 
determine the abundance and distribution of pelagic fish species from October 8 
to November 21, 2014.   

 

 B. Days at Sea (DAS)   

Of the 41 DAS scheduled for this project, __ DAS are funded by an OMAO 

allocation, 41 DAS are funded by a Line Office Allocation, __ DAS are Program 

Funded, and_ DAS are Other Agency funded.  This project is estimated to exhibit 

a High Operational Tempo.  

 C. Operating Area  

Northern GOM between 80o00' and 97o00' W in depths of 30 to 275 fm (Figure 

1).  Approximate station locations will be provided to the Operations Officer on a 

CD for importing into Nobeltec Visual Navigation Suite software. 

D. Summary of Objectives  
1. Primary Objectives 

a. Sample the northern GOM with 90-ft high-opening fish trawl to determine 
the abundance and distribution of pelagic fish species. 

b. Collect length frequency data and biological samples of collected 
species. 

c. Conduct conductivity/temperature/depth (CTD) casts to profile 
temperature, salinity, conductivity, transmissivity, dissolved oxygen 
concentrations, and fluorometry. 

d. Collect ichthyoplankton samples with bongo and neuston samplers to 
map the distribution of fish eggs and larvae. 

e. Collect benthic infauna with a mini multicorer, Shipek grab and/or box 
grab at selected trawl stations. 

f. Collect acoustic data with EK60. 
g. Calibration of the EK60. 

 
2. Secondary Objectives 

a. Conduct additional ichthyoplankton samples with bongo and neuston 
samplers. 

b. Conduct additional trawl sampling. 
c. Conduct additional CTD casts. 

  
 E.  Participating Institutions  

1. National Marine Fisheries Service (NMFS) – Pascagoula Laboratory 

2. Troy University 

3. University of Rhode Island 

4. University of Southern Mississippi 



F. Personnel/Science Party: name, title, gender, affiliation, and nationality  

 

Name (Last, First) Title Leg Date 
Aboard  

Date 
Disembark 

Gender Affiliation Nationality 

Adam Pollack FPC 1 10/8 10/27 M Riverside, 
Pascagoula 

US 

Trey Driggers Fishery 
Biologist 

1 10/8 10/27 M NMFS, 
Pascagoula 

US 

Kevin Rademacher Fishery 
Biologist 

1  
2 

10/8 
11/1 

10/27 
11/21 

M NMFS, 
Pascagoula 

US 

Paul Felts Fishery 
Biologist 

1 10/8 10/27 M NMFS, 
Pascagoula 

US 

Alonzo Hamilton Fishery 
Biologist 

1 10/8 10/27 M NMFS, 
Pascagoula 

US 

Nick Hopkins FMES 1 10/8 10/27 M NMFS, 
Pascagoula 

US 

Ashley Marranzino Volunteer 1 10/8 10/27 F URI US 

Ceil Martinec Volunteer 1 10/8 10/27 F Troy US 

Jonathan Miller Volunteer 1 10/8 10/27 M Troy US 

Matthew Lodato Volunteer 1 
2 

10/8 
11/1 

10/27 
11/21 

M GCRL US 

Michael Hendon FPC 2 11/1 11/21 M NMFS, 
Pascagoula 

US 

Mark Grace Fishery 
Biologist 

2 11/1 11/21 M NMFS, 
Pascagoula 

US 

Kevin Barry Fishery 
Biologist 

2 11/1 11/21 M NMFS, 
Pascagoula 

US 

John Moser Fishery 
Biologist 

2 11/1 11/21 M NMFS, 
Pascagoula 

US 

Keith Bates FMES 2 11/1 11/21 M Riverside, 
Pascagoula 

US 

Lauren Jackson Fishery 
Biologist 

2 11/1 11/21 F Riverside, 
Pascagoula 

US 

Kenny Wilkinson Fishery 
Biologist 

2 11/1 11/21 M NMFS, 
Pascagoula 

US 

 

 G. Administrative  

1. Points of Contacts:  

 a. Field Party Chief: Michael Hendon; 3209 Frederic St., Pascagoula, MS  

39567; (228) 549-1643; Michael.Hendon@noaa.gov 

 b. Field Party Chief: Adam Pollack; 3209 Frederic St., Pascagoula, MS 

39567; (228) 549-1613; Adam.Pollack@noaa.gov 

 c. Trawl Unit Leader: Gilmore “Butch” Pellegrin; 3209 Frederic St., 

Pascagoula, MS  39567; (228) 549-1688; Gilmore.Pellegrin@noaa.gov 

mailto:Michael.Hendon@noaa.gov
mailto:Adam.Pollack@noaa.gov
mailto:Gilmore.Pellegrin@noaa.gov


 d. OPS Officer: Marc Weekley; NOAA Ship Gordon Gunter, 151 Watts 

Avenue, Pascagoula, MS 39567; (228) 769-7905; 

OPS.Gordon.Gunter@noaa.gov 

  2. Diplomatic Clearances: N/A 

  3. Licenses and Permits  

This project will be conducted under the Scientific Research Permits 

(U.S.) issued by National Marine Fisheries Service on April 23, 2013 to 

Brandi Noble. 

a. NMFS Southeast Regional Office 
b. NMFS Sea Turtle Permit 
c. Texas Scientific Research Permit: SPR-0596-796 
d. Louisiana Saltwater Scientific Collection Permit: Permit No. 1953 
e. Mississippi Saltwater Scientific Collection Permit 
f. Alabama Saltwater Scientific Collection Permit 
g. Florida Special Activity License: Permit No. SAL-14-0135-SR 

 

II. Operations  

The Field Party Chief (FPC) is responsible for ensuring that the scientific staff are trained 

in planned operations and are knowledgeable of project objectives and priorities.  The 

Commanding Officer (CO) is responsible for ensuring all operations conform to the 

ship’s accepted practices and procedures. 

A. Project Itinerary 

Leg  Date  Depart/Arrive Location    Sea 

Days 

Leg 1  10/08/2014 Depart Pascagoula, MS                   20 

             10/27/2014 Arrive Pascagoula, MS  

Leg 2  11/01/2014 Depart Pascagoula, MS        21 
   11/21/2014 Arrive Pascagoula, MS  

  
B. Staging and Destaging: 

Pascagoula, MS/Pascagoula, MS 

 

C. Operations to be conducted:  

Operational Plans: 

Upon departure from Pascagoula on October 8, the ship is requested to conduct 

scientific operations at preselected stations between 30 and 275 fm from the 

south Texas coast to the south Florida coast (Figure 1).  The 41-day cruise will 

be conducted in two legs, requiring 24 hr operations with two scientific watches: 
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12 am - 12 pm, 12 pm - 12 am.  The FPC will provide work charts (NOS Coast 

Survey Chart numbers 11420-Havana to Tampa Bay, 11400-Tampa Bay to Cape 

San Blas, 11360-Cape St. George to Mississippi Passes, 11300-Galveston to 

Rio Grande, and 11340-Mississippi River to Galveston) with colored dots 

representing station locations.  Blue dots represent trawling stations and green 

dots represent ichthyoplankton stations.  Hang locations (derived from past 

surveys) will also be identified on charts with yellow dots to assist OODs in 

determining non-trawlable bottom.   

 

Operations at trawling stations will consist of CTD casts followed by trawling 

tows.  At selected trawling sites a bottom grab will be attempted. Operations at 

ichthyoplankton stations will consist of CTD casts followed by bongo and neuston 

tows.  At locations where trawl/ichthyoplankton samplings are combined, 

operations will consist of CTD casts, bongo tows, neuston tows then trawl tows.  

The FPC or Watch Leader may alter the order of activities to facilitate catch 

processing. 

 

Communication between the scientists and the bridge while on station will be 

accomplished via hand held radios. During rough weather, the watch leader with 

consultation from the ship’s crew will determine which sampling gear can be 

deployed safely. The FPC should be notified of any delays to sampling due to 

mechanical, medical, or weather issues as well.  

 

At some point during the cruise we would like to calibrate the EK60.  Ideally we 

would like to anchor the ship in a minimum of 40m of water with minimal wind 

and waves.  If we are not shallow enough to anchor, we would like to conduct the 

calibration while drifting.  We expect this calibration to take 12 to 24 hours to 

complete.   

PRIMARY STATION OPERATIONS 
 
 At the Bridge’s 10 min warning, scientists and deck personnel will proceed to 
duty stations and prepare for station. Scientists and deck personnel should be 
ready and standing by for bridge’s call that the ship is on station and ready to 
proceed. Smoking is not permitted near or while handling any plankton nets due 
to the likelihood of burning holes in the nets. 
 
CTD profiles and environmental data collection  

After the CTD array is overboard, clear of all personnel and being lowered to just 

below the surface, the watch leader (lab scientist) will turn on the power to the 

unit and start the CTD recording. The unit must remain at the surface for 3 min to 

allow the unit to equilibrate to ambient temperature, after which time the unit is 

lowered to approximately 2 m above the bottom or a max depth of 500 m.  After 

the cast, the CTD should be carefully set on deck, taking care not to jar the 

sensitive electronics. At least once a week, a water sample will be taken during a 



CTD cast.  During these casts, the CTD protocol will be as described with the 

exception that the CTD unit will be held at max depth for 1 min, a water sample 

collected, and then retrieved.  The watch leader will clear the y-connections 

periodically throughout the cruise. Additional environmental data collected during 

daylight hours are water color Forel-Ule, percent cloud cover, and sea condition. 

The CTD will be in use 24 hours/day. Dissolved oxygen concentrations from 

sensors on the CTD will be verified using an Orion 3 Star Portable D.O. meter 

made by Thermo Scientific at the beginning of each leg and then every five days 

by the FPC.   

  Trawl Sampling 

At proposed trawling sites, the ship is asked to survey the bottom along the path 

of the upcoming tow to check for obstructions that may damage the trawl. If the 

trawl path is determined to be clear of obstructions, the ship will proceed to 

conduct one tow with the 90-ft trawl. If the trawl path is determined to be 

untrawlable, then the ship is requested to move no more than 5 miles from the 

trawl location and survey again.  A maximum of three surveys will be conducted.  

If after the third survey the trawl path is still untrawlable, then the station will be 

dropped and the ship will proceed to the next station.  Each trawl will be towed 

for 30 min after the gear has sufficiently settled on the bottom as determined by 

the ITI net mensuration system, descent rate charts, and/or judgment of the Chief 

Boatswain.  The net will be towed at approximately 3 to 3.5 kt (speed over 

ground), and exact tow speed will be determined by the behavior of the gear (i.e., 

the head rope will need to be fished at 8 m from the bottom, and the foot rope will 

need to remain near the bottom).  Tow depth will be kept as close to constant as 

possible and depend upon the depth at the beginning of the tow.  At the end of 

the 30 min tow, the ship is requested to quickly increase speed to 5 kt for 2-5 

min.  This pulse will help force fish in the body of the net into the cod end.  Upon 

completing a station, the ship will proceed to the next sampling site.  The deck 

department is requested to shake down the net after each tow to remove all 

organisms.  For larger catches the deck department may be requested to weigh 

the catch with a crane scale.  If the net is damaged during the trawl but there are 

organisms, the deck crew is requested to remove all organisms before 

proceeding with net repair if net repair is at all possible.  In the case of the loss of 

a trawl net, the ship will attempt retrieval of net by towing a chain with a large 

grapple along the trawl track in the opposite direction of the initial tow. The 

amount of time dedicated to trawl retrieval will be decided by the FPC.  At any 

time that the trawl is not secure by the deck department, the scientific party will 

don personal protective equipment (PPE), which includes, but not limited to, work 

vest and hardhat.  In case of extreme mud in the net, the deck department, OOD, 

and watch leader will determine the best way to wash down the gear before the 

catch is emptied from the net.   

 



 Grab Samples 

Grab sample operations will be conducted with a mini multicorer, Shipek Grab 

and/or box corer at designated trawling stations.  The grab will be deployed using 

the bongo winch and cable with an open ocean rated SBE-19 CTD mounted 1-2 

m above the grab. The grab will be connected to the cable by a meter of 

stainless steel chain. The grab will be locked open prior to deployment.  When 

deploying, the deck should zero the wire readout when the SBE-19 is at the 

surface. The grab sampler will be monitored from the lab as it approaches 

maximum depth.  At approximately 15-20 m from the bottom, we will ask the 

desk department to stop the winch for 30 sec before running it into the bottom.  

This will allow the pulse of water associated with the grab to settle down so as 

not to disturb the top layer of silt before impact.  As the grab encounters bottom, 

the chain slackens which causes the hook to release and allows the grab to 

close. Payout and retrieval rates should not exceed 40 m/min.  If no sample is 

collected, the watch leader may or may not decide to do another attempt 

depending on time constraints. 

Bongo sampling 

The SEAMAP bongo plankton sampler is comprised of two 61 cm diameter 

collars with two 0.335 mm mesh nets. Prior to deployment of the bongo sampler, 

the watch leader must run software programs and prepare them for the bongo 

cast. The watch leader (lab scientist) will inform the deck when to power up the 

SBE-19 SEACAT, at which time the deck scientist will turn on the magnetic 

switch at the appropriate time. The bongo sampler is towed in an oblique path 

from near bottom, or 200 m max, to the surface. The SBE-19 SEACAT which is 

mounted above the bongo array on the sea cable will be used to monitor the tow 

path of the bongo net. Vessel speed should be adjusted during the bongo tow to 

maintain a 45 wire angle in order to uniformly sample throughout the water 

column. If angle exceeds 55, falls below 35 or if the combined variation 

exceeds 15, then the tow must be repeated (the samples will be saved until a 

better tow is completed). The net depth will be monitored by the watch leader. 

The deck scientist (or winch operator) will report wire angles periodically during 

downcast. On the watch leader’s command at max depth, the winch operator will 

stop payout of cable and immediately start retrieval (do not allow net to settle). At 

that time, the wire angle and wire out should be reported to the watch leader from 

the deck. The watch leader will ask the winch operator to slowly retrieve the 

bongo array at 20 m per min for tow depths of 100 m or deeper; for shallower 

stations the retrieval rate will be determined at each station based on station 

depth. The wire angle and remaining wire out should be reported from the deck 

to the watch leader regularly or as requested (on upcast or downcast).  

The deck personnel should report when the bongo array breaks the surface. 

Time will be recorded to the second (by the lab scientist) when the net breaks 



surface and flowmeters stop turning, at which time the winch operator 

immediately pulls the frame from the water; taking care not to let the bongo array 

continue to fish once it breaks the surface. When possible, the sample will be 

rinsed into the cod end of the net with a seawater hose while the net hangs over 

the side. In high winds, the scientist may request that the net is brought directly 

on board and rinsed down completely on deck. The bongo frame and net are 

finally placed on deck.  

Great care must be taken not to rest the frame on the nets, scrape the net with 

the frame against the deck, or walk on the plankton nets. The abrasions can 

easily cause holes in the nets requiring repair or replacement of these expensive 

sampling devices.  

If bottom sediment is present in both samples, the tow must be repeated. Any 

marginal sample will be saved until completion of the next tow. If bottom 

sediment (no more than 2 Tb) is present in only one sample the tow need not be 

repeated. Right bongo samples will be preserved in 95% Ethyl alcohol (ETOH) 

and transferred to new 95% ETOH after 24 h. Left bongo samples will be 

preserved in 10% formalin initially and transferred to 95% ETOH after 36 h. 

*Preservation methods subject to change. 

Neuston sampling 

The neuston net is a 1 x 2 m frame outfitted with a 0.947 mm mesh net. Each 

neuston tow will be conducted for 10 min at a vessel speed of approximately 2 kt 

to keep half the frame submerged in the water (i.e., maintain a sampling depth of 

0.5 m). If necessary, the ship will steam forward in a wide arc to keep the 

neuston net (mouth opening) out of the influence of the prop wash. The duration 

of a neuston tow may be shortened to no less than 5 min when high 

concentrations of jellyfish, ctenophores, Sargassum, floating weed and/or debris 

are present in the water, or weather requires it. After retrieval, the sample is 

rinsed into the cod end with seawater while the net hangs over the side (if windy, 

deck scientist may request net to be brought directly on board and rinsed on 

deck). Neuston samples will be preserved in 95% ETOH initially and transferred 

to new 95% ETOH after 24 h. 

*Preservation methods subject to change 
 
While on board the NOAA ship all spent formalin and ethanol will be kept 

separate and collected into individual 55 gallon drums for recycling/disposal on 

land. The lab will be responsible for storing and shipping the spent chemicals. 

Acoustics 
Required Equipment 

 Simrad EK 60 Splitbeam Echosounders operating at  
o 18 kHz 



o 38 kHz 
o 120 kHz 
o 200 kHz 

 Transducer layout plan showing location of EK60 transducers relative to ship 
frame numbers 

 Calibration rigging equipment: 
o 3 Outrigger poles, 18 feet long 
o Manual control reels on Gordon Gunter  
o Downrigger control system: Manual control reels on Gordon Gunter  
o 3 Handheld VHF radios for use on deck 
o 1 VHF radio (Handheld or Fixed) at echosounder workstation in 

acoustics lab 

 CTD to measure temperature and salinity to 50m depth prior to calibration 

 Calibration target (Supplied by MS Labs): 
o Material: Tungsten-carbide with 6% Cobalt binder 
o Surface Quality: Grade 25 
o Diameter: 38.1mm 

 Other equipment (supplied by MS Labs): 
o 200 feet of lightweight nylon twine 
o 1 lb. weight or shackle 
o 4 lb. weight 
o Spectra fishing line to suspend target 
o Dishwashing liquid 

Ship Requirements 

 Perform CTD cast to provide temperature and salinity for upper 50m of water 
column 

 Ship will drift, without maneuvering, in water at least 40 m deep with wind 
initially on the port side. 

 Ship will periodically be required to make a slow turn to put wind on opposite 
side. This maneuver will probably be required once for each of four EK60 
transducers. 

 Except for emergencies, maneuvering should only occur at scientists request 
and must be done very slowly to prevent fouling the suspended calibration 
gear. 

 Ship will refrain from discharging waste during calibration activities. 
Weather Requirements 

 Low (ideally zero) winds and calm (ideally flat) seas are necessary to make 
calibration successful 

 If the ship drifts at a speed through the water of 2 kt  or more it is very difficult 
to control the location of the calibration target and perform a worthwhile 
calibration of the echosounder system 

Procedures 

 Preparation 
o Conduct CTD cast to obtain measurements of temperature and 

salinity for upper 50m of water column 
o ER60 Software settings 

 Set transducer depths to zero 
 Set Ping Control to Interval and Rate to 1 sec 
 Set echogram range to 40m 



 Set data recording range to 60m 

 Deploying Calibration Target 
o Calibration target must be kept clean and not dropped on deck or 

banged against hull during deployment. Scratches or other damage 
and oil or other contaminants on the surface of the sphere will alter its 
acoustic target strength. Prior to calibration, soak target sphere in a 
solution of 1-part dishwashing liquid and 4-parts water to discourage 
entrapment of bubbles on sphere surface when immersed in seawater 
for calibration. Otherwise calibration target should be kept in its 
protective case 

o Mount Outriggers 
o Rig snap swivels on ends of downrigger lines through pulleys on 

outriggers 
o Lower ends of downrigger lines to sea surface and set depth counters 

to zero; depth counters should not be reset again during calibration 
o Bring ends of the two downrigger lines on one side of ship up to a 

common point midway between the mounting locations 
o Pull the downrigger line from the other side of the ship under hull to 

attach to the two lines 
 Position 1 lb weight at midpoint of 200 ft nylon cord 
 Drop weight from bow of vessel and walk the ends of cord 

back to the single outrigger position on one side and midpoint 
of outrigger locations on other side 

 Attach end of cord to single downrigger line and lower until 
counter indicates 150 ft depth 

 Retrieve the cord from the other side and attach swivels of all 
three lines together 

o Attach monofilament loop on calibration target to spectra fishing line 
with 4 lb weight attached at lower end and upper end attached to 
three downrigger lines.  

 Length of line between the target and the weight, and between 
the target and downrigger swivels must be at least two 
acoustic pulse lengths. 

 For 1 msec acoustic pulse lengths, 5 m spacing is 
recommended 

o Lift the calibration target out of detergent solution using the line and 
without touching it lower it and the 4lb weight into the water 

o Lower 4 lb weight and target until they are suspended from two 
outriggers 

o Simultaneously lower two outriggers so counters read 115’ 
o Return opposite downrigger from 140’ to 115’ 
o Adjust downriggers so that echoes from calibration target are 

observed near center of the beam of the first transducer to be 
calibrated, at approximately 25m depth 

 Collect Calibration Data 
o Calculate the average temp and salinity for upper 30m of water 

column, enter these values in ER60 Environment dialog window 
o Start recording of raw data 
o Calculate sphere target strength at each EK60 frequency using the 

specific depth, temperature, and salinity of the sphere location 



o Start and follow the Calibration procedure from the EK60 Operations 
Manual for the first transducer 

o Adjust position of target in transducer beam to collect at least 25 
echoes in each quadrant of the beam 

o Echoes near the center of the beam are most important for estimating 
biomass 

o If the downriggers can’t be adjusted to put the target in windward 
portions of the transducer beam, the ship must be turned to make that 
the leeward side of the transducer beam 

o When enough target echoes have been collected with the first 
transducer, Save the results and continue with the other transducers 
in the same fashion 

 Recover Calibration Target 
o Lower the single outrigger on one side so that the calibration target 

can be retrieved 
o Rinse the calibration target in fresh water and store it safely 

 Resume survey data collection 
Collection 
There are five main considerations for EK60 operation: (1) minimizing the impact on 
other scientific activities, (2) minimizing the interference from other instruments, (3) 
settings for data collection, (4) record keeping, and (5) data analysis. 

1. The EK60 will operate continuously night and day.  The ST or ET on duty will be 
responsible for turning the EK60 on or off so that the bridge sounders may be 
operated as determined by the OOD. 

2. When the EK60 is running, it should be synchronized with the ES60, and ADCP.  
The EK60 display should be checked periodically for evidence of interference 
from other acoustic systems. 

 

Parameter settings that need to be checked: 

 Ping interval: 2 seconds for all depths. Set via the ‘interval’ data entry 
window at the top left of the EK60 Simrad data collection program. 

 The pulse width for 18 kHz, 38 kHz, 120 kHz and 200 kHz will be 1.0 ms. 

 Maximum sample range: 2000m. Set via the pull-down menu: Output-
>File->Raw Data->Range 

 Bottom Tracking Function: Disabled at 120, and 200 kHz (when doing so 
does not conflict with the needs of other users). 18 kHz: max set to 6000 
m; 38 kHz: max 2000 m. Set for each frequency by right-clicking on the 
bottom depth display found at the top of each channel’s window. 

 Make sure data recording is on! 
 

3. Each night, probably during a transect between trawl stations, try to collect 5 min 
of data with all frequencies set to passive mode and the vessel maintaining 
survey speed. Set the mode under Operation->Normal to Passive for each 
frequency. Remember to set the modes back to Active afterwards. 
 

4. It is useful to keep track of all changes made to the operation of the EK60 in the 
SCS acoustic event log  

 



5. Output directory is set via Output->File->Directory. There will be a folder for the 
cruise on the portable Seagate hard-drive named F:/HB201303/EK60_Leg## (eg 
Leg01) 

 

6. Data recording is started by hitting the red arrow button. The display at the 
bottom of the window will then say ‘RECORD ON’ 

 

Modifications to Field Operations 

Sampling protocol may be altered by the FPC or watch leader in order to 

optimize sampling for time conservation. The FPC may alter the project 

instructions in order to accomplish mission objectives but will do so only after 

consulting with the CO. If additional time becomes available during a leg, the 

FPC will provide the ship with further station locations at that time, after 

consulting with the CO. 

D. Dive Plan  

All dives are to be conducted in accordance with the requirements and 
regulations of the NOAA Diving Program (http://www.ndc.noaa.gov/dr.html) and 
require the approval of the ship’s CO.  
 

Scientific dives are not planned for this project.  If the ship must conduct dive ops 
while at sea the CO will confer with the FPC as to when the dive ops will occur so 
the dive will have the least impact on the scientific work. 

 
E. Applicable Restrictions  

 

Conditions which preclude normal operations: adverse weather conditions. 

III.   Equipment 
Equipment and Capabilities Provided by the Ship: 
1. SCS version 4.7.0 
2. Net reel - for spooling the 90 ft HBOT 
3. Because of the importance of the CTD equipment package to record environmental 

data and the need for the Scientific Computing System (SCS), an Electronics 
Technician is imperative. 

4. Trawl winches with sufficient wire to fish in 275 fm depths and meter readouts to 
determine warp length  

5. Hydrographic winch with wire and meter readout to accomplish CTD/bottle casts and 
bongo tows up to a 200 m depth. Winch speed should be variable to include 50 m/min 
during pay-out and 20 m/min during haul back (for bongo tows). Spare slip rings for 
each winch. Fully functional wire readouts for each winch. 

6. Winch, crane, and wire for deploying neuston net. 
7. One (1) Primary SBE 9plus CTD configured as follows; 

a. Unit should be mounted horizontally and mounted in the water sampling frame. The 
frame should be examined to ensure it is in good physical condition and there are 
no breaks present in any of the welds supporting the frame. 

b. The standard 12 position SBE 32 Carousel should be properly mounted in the water 

http://www.ndc.noaa.gov/dr.html


sampler section of the frame and tested to ensure that all 12 bottle positions are 
working properly and respond to software requests for firing. 

c. The internal Digiquartz pressure sensor should be in good working order and have a 
calibration/service date not to exceed 365 days. 

d. The primary sensor suite should be installed and consist of the following (the 
sensors should have a calibration date as recent as possible, not to exceed 365 
days): 

i. One (1) SBE 3 Premium Temperature sensor 
ii. One (1) SBE 4 Conductivity sensor 
iii. One (1) SBE 43 Dissolved Oxygen sensor 
iv. One (1) “Y” air bleeder valve. Valve should be checked to ensure it is not clogged. 
v. One (1) Wetlabs Wetstar pumped fluorometer 
vi. One (1) SBE 5T pump that has been checked by Seabird within the last 365 days 

for proper operation 
vii. One (1) Wetlabs C-Star transmissometer 
viii. Proper plumbing. Tubing should be checked to ensure it meets Seabird’s 

recommended method of plumbing and is free from cracks and holes. With red 
end caps for proper storage between stations. 

e. The secondary sensor suite should be installed and consist of the following (the 
sensors should have a calibration date as recent as possible, not to exceed 365 
days): 
i. One (1) SBE 3 Premium Temperature sensor 
ii. One (1) SBE 4 Conductivity sensor 
iii. One (1) SBE 43 Dissolved Oxygen sensor 
iv. One (1) “Y” air bleeder valve. Valve should be checked to ensure it is not clogged 
v. One (1) Wetlabs Wetstar pumped fluorometer 
vi. One (1) SBE 5T pump that has been checked by Seabird within the last 365 days 

for proper operation 
vii. One (1) Wetlabs C-Star transmissometer 
viii. Proper plumbing. Tubing should be checked to ensure it meets Seabird’s 

recommended method of plumbing and is free from cracks and holes. 
f. The unit should be properly terminated and connected to a properly functioning SBE 

11 Deck Unit. The deck unit should be connected to allow the following: 
i. Proper control of the SBE Water Sampler Carousel via the SEASAVE application 
ii. Integration of a proper NMEA signal from a GPS unit. 

6. A second SBE 9plus profiler should be available as well. Unit does not have to be 
configured as a complete functioning ready-to-install on the sea cable unit; however, it 
should have the following components available: 

a. Sensors for a Primary suite (with a calibration date as recent as possible, not to 
exceed 365 days): 
i. One (1) SBE 3 Premium Temperature sensor 
ii. One (1) SBE 4 Conductivity sensor 
iii. One (1) SBE 43 Dissolved Oxygen sensor 
iv. One (1) “Y” air bleeder valve. Valve should be checked to ensure it is not clogged. 
v. One (1) Wetlabs Wetstar pumped fluorometer 
vi. One (1) SBE 5T pump that has been checked by Seabird within the last 365 days 

for proper operation. 
vii. One (1) Wetlabs C-Star transmissometer 
viii. Proper plumbing. Tubing should be checked to ensure it meets Seabird’s 

recommended method of plumbing and is free from cracks and holes. 
b. Sensors for a complete Secondary suite (with a calibration date as recent as possible, 



not to exceed 365 days): 
i. One (1) SBE 3 Premium Temperature sensor 
ii. One (1) SBE 4 Conductivity sensor 
iii. One (1) SBE 43 Dissolved Oxygen sensor 
iv. One (1) “Y” air bleeder valve. Valve should be checked to ensure it is not clogged. 
v. One (1) Wetlabs Wetstar pumped fluorometer 
vi. One (1) SBE 5T pump that has been checked by Seabird within the last 365 days 

for proper operation. 
vii. One (1) Wetlabs C-Star transmissometer. 
viii. Proper plumbing. Tubing should be checked to ensure it meets Seabird’s 

recommended method of plumbing and is free from cracks and holes. 
7. A second SBE 11 Deck Unit should be on the ship to be put into service if needed. 
8. Two (2) fully operational SBE 19 Seacat profilers should be available. One of the units 

should be installed on the sea cable. Both units should have calibration dates not to 
exceed 365 days. 

9. Two (2) functional SBE 36 Deck units should be available, 1 for backup, which are 
configured for the model Seacat being supplied. 

10. Two (2) PDIM units should be available for use with the SBE 19 units. One of these 
PDIM units should be installed on the primary SBE19 on the sea cable. These PDIM units 
should also be the proper units that are used with the model Seacat being used. 

11. A fully functional SBE 45 thermosalinograph should be available for the survey. The unit 
should have calibrations that do not exceed 365 days. The calibration data must be 
verified/entered into the SEABIRD-TSB.CAL file in the Ship Directory of SCS. 

12. It is highly desirable to have the following additional spare sensors on-board if possible: 
a. One (1) SBE 43 DO Sensor 
b. One (1) SBE 3 Temperature Sensor 
c. One (1) SBE 4 Conductivity Sensor 
d. One (1) Wetlabs Wetstar pumped fluorometer 
e. One (1) Wetlabs C-Star Transmissometer 
f. One (1) SBE 5T Pump 

14. Copies of all calibration sheets for CTD profilers, TSG, and spare sensors should be 
provided to the laboratories’ Shipboard System Specialist prior to sailing. 

15. CTD capable winch and A-frame for CTD casts, with sufficient electromechanical cable 
for casts to 500 m. 

16. NMEA GPS input to CTD header file. 
17. Inside and outside conveyor belts for processing catches. 
18. Freezer space for preserving scientific specimens. 
SCS data requested:  
The SCS system should be fully operational for the duration of the survey. Due to the nature 
of the survey work, we request that all the events (CTD, Bongo, Neuston, Bottom Grabs, 
and trawls) be conducted from the dry lab.  A listing of any sensors that will not be functional 
for the survey should be provided prior to sailing to the FPC, taking into consideration that 
event templates will have to be checked by the Shipboard System Specialists to ensure 
there will be no impact or an alternative sensor can be selected. 

a. SIMRAD - primary 
i. UTC time 
ii. Latitude 
iii. Longitude 
iv. Speed over ground 
v. Course over ground 

b. SIMRAD - secondary 



i. Latitude 
ii. Longitude 
iii. Speed over ground 
iv. Course over ground 

c. Furuno doppler speed log 
i. Speed through the water 
ii. Speed over ground 

c. EQ50 and EK60 depth in meters 
d. Gyro-heading 
e. Air temperature (°C) 
f. Corrected barometric pressure 
g. True wind speed 
h. True wind direction 
i. Information should be passed to the Rotating ET to ensure the following: 

i. The Automatic Logger Control on the SCS Server must be enabled anytime ACQ is 
started and should use the default of 0:00:00 (Midnight GMT). 

ii. The contents of the Eventdata folder should be allowed to remain present for the 
duration of the survey (they should not be deleted between legs). This will ensure 
that event IDs do not restart for the respective events during the survey. 

j. SEASAVE SOFTWARE: Prior to sailing, the proper .CON files should be built in 
SEASAVE. The software should be set to look for the proper .CON file for the 
respective instrument. 

k. It is also highly desirable that the ASCII Out function be allowed to feed CTD data into 
SCS via serial cable. 

20. DRYLAB REMOTE COMPUTERS - Due to the nature of the work involved with data 
collection for this survey, it is recommended that all three (3) FSCS Remote units be 
verified for the following prior to sailing: 

a. All 3 computers are 100% operational 
b. All 3 computers are properly setup to interface as SCS clients 
c. Two (2) of the units have a functioning copy of Microsoft Office XP Professional.  The 

Office suite must provide at minimum the following programs: Word, Excel, 
PowerPoint and Access. 

d. All 3 computers must be able to print to a functioning printer. 
 

B. Equipment and Capabilities Provided by the Scientists: 
1. 90-ft HOBT survey trawls (4); and bridles and rigging (3 sets) 
2. Winch for deploying bottom grabs 
3. 3.5m steel doors (2 sets) 
4. Trawl hardware box 
5. Spare webbing and net repair materials 
6. Simrad ITI Net Mensuration System 
7. Three electronic fish measuring boards 
8. Three touch screen monitors for the FSCS 
9. Five hundred plastic specimen bags 
10. Five Marel 1100 electronic weighing scales 

i. Two 30-kg capacity 
ii. Three 6-kg capacity 

11. Field data sheets 
12. Crane scale 
13. Fish baskets, shovels, sorting rakes and trays 



14. Mini Multicorer (1) 
15. Shipek bottom grab (1) 
16. Box corer (1) 
17. Two 61-cm bongo frames 

18. Two 12 m neuston frames 
19. Bongo/neuston gear and equipment box 
20. Plankton sampling supplies box 
21. Plankton preserving jars and lids 
22. Chemical transfer pumps 
23. 3 Niskin bottles 
24. Safety goggles 
25. Latex and Nitrile puncture resistant work gloves 
26. Grapple and chain for retrieving lost trawl 
27. Handheld Orion 3 star meter and equipment box 
28. 5 ICOM VHF Marine handheld radios (IC-M72) 
29. Various clerical supplies 
30. Computer for FPC stateroom 
31.  Spent chemical collection Drum 
32. Dissecting Microscopes 2  
33. Plankton Table 
34. Fish and Invertebrate Identification Reference Materials 
35. Vermiculite or kitty litter (chemical absorbent) 
36. Toughbook (hooked to the ships public internet) 

 

IV. Hazardous Materials  

 A. Policy and Compliance  

The FPC is responsible for complying with FEC 07 Hazardous Materials and Hazardous 

Waste Management Requirements for Visiting Scientific Parties (or the OMAO 

procedure that supersedes it).  By Federal regulations and NOAA Marine and Aviation 

Operations policy, the ship may not sail without a complete inventory of all hazardous 

materials by name and quantity, MSDS, appropriate spill cleanup materials (neutralizing 

agents, buffers, or absorbents) in amounts adequate to address spills of a size equal to 

the amount of chemical brought aboard, and chemical safety and spill response 

procedures.  Documentation regarding those requirements will be provided by the Chief 

of Operations, Marine Operations Center, upon request. 

Per OMAO procedure, the scientific party will include with their project instructions and 
provide to the CO of the respective ship 30 days before departure: 

 List of chemicals by name with anticipated quantity 

 List of spill response materials, including neutralizing agents, buffers, and absorbents  

 Chemical safety and spill response procedures, such as excerpts of the program’s 
Chemical Hygiene Plan or SOPs relevant for shipboard laboratories 

 For bulk quantities of chemicals in excess of 50 gallons total or in containers larger than 
10 gallons each, notify ship’s Operations Officer regarding quantity, packaging and 
chemical to verify safe stowage is available as soon as chemical quantities are known.  



Upon embarkation and prior to loading hazardous materials aboard the vessel, the 

scientific party will provide to the CO or their designee: 

 An inventory list showing actual amount of hazardous material brought aboard 

 An MSDS for each material 

 Confirmation that neutralizing agents and spill equipment were brought aboard 
sufficient to contain and cleanup all of the hazardous material brought aboard by 
the program 

 Confirmation that chemical safety and spill response procedures were brought 
aboard 

Upon departure from the ship, scientific parties will provide the CO or their designee an 
inventory showing that all chemicals were removed from the vessel. The CO’s designee 
will maintain a log to track scientific party hazardous materials. MSDS will be made 
available to the ship’s complement, in compliance with Hazard Communication Laws.  

Scientific parties are expected to manage and respond to spills of scientific hazardous 

materials. Overboard discharge of hazardous materials is not permitted aboard NOAA 

ships.  

B.  Inventory 

Common Name 
of Material 

Qty Notes Trained 
Individual 

Spill 
control 

Formaldehyde 
solution (10%) 

1 x 2.5 gal  See C.1 Below See C.1 

Below 

Ethanol 1 x 55 gal drum  See C.1 Below See C.1 

Below 

Triton X(1%) 1 x 1 pint  See C.1 Below See C.1 

Below 

10% buffered 
formalin 

1 x 5 L  See C.1 Below See C.1 

Below 

Isopropanol 1 x 1 L  See C.1 Below See C.1 

Below 

Glutaraldehyde 
in sodium 
cacodylate buffer 

1 x 30 cc  See C.1 Below See C.1 

Below 

C.  Chemical safety and spill response procedures 

1. Precaution – all personnel handling chemicals will wear the appropriate PPE.  

All personnel are trained in handling chemicals. 



2.  Prevention – all chemicals will be secured before the survey departs.  All 

personnel will be aware of the location of all chemicals.  A MSDS for all 

chemicals brought aboard will be given to the ship before sailing. 

3.  Response – if a spill occurs scientists will immediately leave the area and alert the 

bridge.  Scientists will defer to the ship’s spill plan for a cleanup.  Kitty litter and formalin 

neutralizing agent will be on board for potential spill cleanups.  D. Radioactive Materials: N/A     

 E. Inventory (itemized) of Radioactive Materials: N/A  

V. Additional Projects  

 A. Supplementary (“Piggyback”) Projects: N/A 

 B. NOAA Fleet Ancillary Projects: N/A 

VI. Disposition of Data and Reports  

Disposition of data gathered aboard NOAA ships will conform to NAO 216-101 Ocean Data 

Acquisitions and NAO 212-15 Management of Environmental Data and Information.  To guide 

the implementation of these NAOs, NOAA’s Environmental Data Management Committee 

(EDMC) provides the NOAA Data Documentation Procedural Directive (data documentation) 

and NOAA Data Management Planning Procedural Directive (preparation of Data Management 

Plans).  OMAO is developing procedures and allocating resources to manage OMAO data and 

Programs are encouraged to do the same for their Project data. 

A. Data Classifications:  Under Development 

 

a. OMAO Data 

 

b. Program Data 

 

B. Responsibilities:  Under Development 

VII. Meetings, Vessel Familiarization, and Project Evaluations 

A. Pre-Project Meeting:  The FPC and CO will conduct a meeting of pertinent 

members of the scientific party and ship’s crew to discuss required equipment, 

planned operations, concerns, and establish mitigation strategies for all 

concerns.  This meeting shall be conducted before the beginning of the project 

with sufficient time to allow for preparation of the ship and project personnel.  The 

ship’s Operations Officer usually is delegated to assist the FPC in arranging this 

meeting.  

 

B. Vessel Familiarization Meeting:  The CO is responsible for ensuring scientific 

personnel are familiarized with applicable sections of the standing orders and 

vessel protocols, e.g., meals, watches, etiquette, drills, etc.  A vessel 



familiarization meeting shall be conducted in the first 24 hr of the project’s start 

and is normally presented by the ship’s Operations Officer. 

 

C. Post-Project Meeting:  The CO is responsible for conducting a meeting no earlier 

than 24 hrs. before or no later than seven days after the completion of a project 

to discuss the overall success and short comings of the project.  Concerns 

regarding safety, efficiency, and suggestions for future improvements shall be 

discussed and mitigations for future projects will be documented for future use.  

This meeting shall be attended by the ship’s officers, applicable crew, vessel 

coordinator, FPC, and members of the scientific party and is normally arranged 

by the Operations Officer and FPC. 

 

D. Project Evaluation Report  

Within seven days of the completion of the project, a Ship Operation Evaluation 

form is to be completed by the FPC. The preferred method of transmittal of this 

form is via email to OMAO.Customer.Satisfaction@noaa.gov.  If email is not an 

option, a hard copy may be forwarded to: 

   Director, NOAA Marine and Aviation Operations 

   NOAA Office of Marine and Aviation Operations 

   8403 Colesville Road, Suite 500 

   Silver Spring, MD  20910 

VIII. Miscellaneous  

 A. Meals and Berthing  

The ship will provide meals for up to 15 scientists.  Meals will be served three times 

daily. Since the watch schedule is split between day and night, the night watch may 

often miss daytime meals and will require adequate food and beverages (for example a 

variety of sandwich items, cheeses, fruit, milk, juices) during what are not typically meal 

hours. Special dietary requirements for scientific participants will be made available to 

the ship’s command at least seven days prior to the project. 

Berthing requirements, including number and gender of the scientific party, will be 

provided to the ship by the FPC. The FPC and Operations Officer will work together on a 

detailed berthing plan to accommodate the gender mix of the scientific party taking into 

consideration the current make-up of the ship’s complement. The FPC is responsible for 

ensuring the scientific berthing spaces are left in the condition in which they were 

received; for stripping bedding and linen return; and for the return of any room keys 

which were issued. The FPC is also responsible for the cleanliness of the laboratory 

spaces and the storage areas utilized by the scientific party, both during the project and 

at its conclusion prior to departing the ship. 

mailto:OMAO.Customer.Satisfaction@noaa.gov


All NOAA scientists will have proper travel orders when assigned to any NOAA ship. The 

FPC will ensure that all non NOAA or non-Federal scientists aboard also have proper 

orders. It is the responsibility of the FPC to ensure that the entire scientific party has a 

mechanism in place to provide lodging and food and to be reimbursed for these costs in 

the event that the ship becomes uninhabitable and/or the galley is closed during any part 

of the scheduled project.  

All persons boarding NOAA vessels give implied consent to comply with all safety and 

security policies and regulations which are administered by the CO. All spaces and 

equipment on the vessel are subject to inspection or search at any time. All personnel 

must comply with OMAO's Drug and Alcohol Policy dated May 17, 2000 which forbids 

the possession and/or use of illegal drugs and alcohol aboard NOAA Vessels. 

 B. Medical Forms and Emergency Contacts 

The NOAA Health Services Questionnaire (NHSQ, Revised: 02 JAN 2012) must be 

completed in advance by each participating scientist. The NHSQ can be obtained from 

the FPC or the NOAA website 

http://www.corporateservices.noaa.gov/~noaaforms/eforms/nf57-10-01.pdf. The 

completed form should be sent to the Regional Director of Health Services at Marine 

Operations Center. The participant can mail, fax, or scan and send via secure e-mail the 

form using the contact information below; participants should take precautions to protect 

their Personally Identifiable Information (PII) and medical information. The NHSQ should 

reach the Health Services Office no later than 4 weeks prior to the project to allow time 

for the participant to obtain and submit additional information that health services might 

require before clearance to sail can be granted. Please contact MOC Health Services 

with any questions regarding eligibility or completion of the NHSQ.  Be sure to include 

proof of tuberculosis (TB) testing, sign and date the form, and indicate the ship or ships 

the participant will be sailing on. The participant will receive an email notice when 

medically cleared to sail if a legible email address is provided on the NHSQ.  

Contact information:  

Regional Director of Health Services 
Marine Operations Center – Atlantic 
439 W. York Street 
Norfolk, VA 23510 
Telephone 757-441-6320 
Fax 757-441-3760 
E-mail MOA.Health.Services@noaa.gov 

 

 

Prior to departure, the FPC must provide an electronic listing of emergency contacts to 

the Executive Officer for all members of the scientific party, with the following 

information: contact name, address, relationship to member, and telephone number. 

  

http://www.corporateservices.noaa.gov/~noaaforms/eforms/nf57-10-01.pdf
mailto:MOA.Health.Services@noaa.gov


  C. Shipboard Safety  

Hard hats are required when working with suspended loads.  Work vests are required 
when working near open railings and during small boat launch and recovery 
operations.  Hard hats and work vests will be provided by the ship when required. 
 
Wearing open-toed footwear or shoes that do not completely enclose the foot (such as 
sandals or clogs) outside of private berthing areas is not permitted.  At the discretion of 
the ship’s CO, safety shoes (i.e. steel or composite toe protection) may be required to 
participate in any work dealing with suspended loads, including CTD deployment and 
recovery.  The ship does not provide safety-toed shoes/boots.  The ship’s Operations 
Officer should be consulted by the FPC to ensure members of the scientific party report 
aboard with the proper attire. 
 
D. Communications 

A progress report on operations prepared by the FPC may be relayed to the program 

office.  Sometimes it is necessary for the FPC to communicate with another vessel, 

aircraft, or shore facility. Through various means of communications, the ship can 

usually accommodate the FPC.  Special radio voice communications requirements 

should be listed in the project instructions.  The ship’s primary means of communication 

with the Marine Operations Center is via e-mail and the Very Small Aperture Terminal 

(VSAT) link.  Standard VSAT bandwidth at 128kbs is shared by all vessel staff and the 

science team at no charge. Increased bandwidth in 30 day increments is available on 

the VSAT systems at increased cost to the scientific party.  If increased bandwidth is 

being considered, program accounting is required and it must be arranged at least 30 

days in advance. 

E. IT Security 

Any computer that will be hooked into the ship's network must comply with the OMAO 

Fleet IT Security Policy 1.1 (November 4, 2005) prior to establishing a direct connection 

to the NOAA WAN. Requirements include, but are not limited to:  

(1) Installation of the latest virus definition (.DAT) file on all systems and performance 

of a virus scan on each system.  

(2) Installation of the latest critical operating system security patches.  

(3) No external public Internet Service Provider (ISP) connections.  

Completion of the above requirements prior to boarding the ship is required. 

Non-NOAA personnel using the ship's computers or connecting their own computers to 

the ships network must complete NOAA’s IT Security Awareness Course within three 

days of embarking. 

 F. Foreign National Guests Access to OMAO Facilities and Platforms  

Foreign National access to the NOAA ship or Federal Facilities is not required for this 

project.   



VIII. Appendices  

 1. Figures, maps, tables, images, etc. 
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 Figure 1. Operational area for NOAA Ship Gordon Gunter GU-14-06. 

 




